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Understanding Model Space and Paper Space 
 

First, let's give you plain definitions of these two things: 
Model Space is one of the two primary spaces in which AutoCAD objects reside. Typically, a geometric 
model is placed in a three-dimensional coordinate space called model space. A final layout of specific 
views and annotations of this model is placed in paper space 
Paper Space is used for creating a finished layout for printing or plotting, as opposed to doing drafting or 
design work. You design your paper space viewports using a layout tab. Model space is used for creating 
the drawing. You design your model using the Model tab. 
 

As you design your model drawing and prepare it for plotting, you can use model space and paper space 
just as with previous AutoCAD® releases. Using AutoCAD 2000, however, the environment you use to 
layout and prepare your drawing for plotting is much more visual. At the bottom of the drawing window 
are tabs that include the Model tab and one or more layout tabs. Model space can be accessed from the 
Model tab or by making a floating viewport in a layout current. The Model tab is where you spend most of 
your time creating and editing your drawing. When you are in the Model tab, you are always working in 
model space. You can divide the Model tab into tiled viewports to represent various views of your model. 
You can also plot your drawing from the Model tab. 
 

When you are ready to setup your drawing for plotting, you can use a layout tab. Each layout tab provides a 
paper space drawing environment in which you can create viewports and specify page settings for each 
layout you want to plot. Page settings are just plot settings that are saved with the layout. As you designate 
page settings for a layout, you can choose to save and name the page settings for one layout, then apply that 
named page setup to another layout. You can also create a new layout from an existing layout template 
(.dwt or .dwg) file into a new layout. 
 

Paper space represents the paper on which you arrange the drawing prior to plotting. With AutoCAD 2000, 
single or multiple paper space environments can be easily designed and manipulated using layout tabs. 
Layouts are accessible by choosing a layout tab at the bottom of the drawing area. Each layout represents 
an individual plot output sheet, or an individual sheet in a drawing project. As you create a new layout, you 
can add floating viewports to plot. Once you've created floating viewports in a layout, you can apply 
different scales to each view within the viewport, and specify different visibility for layers in the viewport. 
 

If you want to use plot styles, you can also attach a plot style table to a layout or viewport. A plot style 
table contains all of the plot styles that you want to apply to the objects in the drawing when you plot. 
 
Understanding Plot Styles 
 

AutoCAD 2000 provides a new object property called plot style that can change the way a plotted drawing 
looks. By modifying an object's plot style, you can override that object's color, linetype, and lineweight. 
You can also specify end, join, and fill styles as well as output effects such as dithering, gray scale, pen 
assignment, and screening. You can use plot styles if you need to plot the same drawing in different ways.  
Every object and layer has a plot style property. The actual characteristics of plot styles are defined in plot 
style tables that you can attach to the Model tab and layouts within layouts. If you assign a plot style to an 
object, and then detach or delete the plot style table that defines that plot style, the plot style will have no 
effect on the object. By attaching different plot style tables to layouts, you can create different looks for 
your plots. 
 

There are two plot style modes: Color-Dependent and Named. Each drawing you open in AutoCAD 2000 is 
in either one mode or the other. You can change the mode for new drawings and for drawings created in 
earlier versions of AutoCAD that haven't been saved in AutoCAD 2000 yet. The plot style mode setting is 
available on the Plotting tab in OPTIONS. 
 

Color dependent plot styles are based on object color. There are 255 color-dependent plot styles. In a color-
dependent plot style table, you cannot add, delete, or rename color-dependent plot styles. You can control 
the way all objects of the same color plot in color-dependent mode by adjusting the plot style that 
corresponds to that object color. In color-dependent model, you can change the plot style that is used for an 
object by changing the object's color. Color-dependent plot style tables are stored in files with the extension 
.ctb. 
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If you used pen assignments in earlier releases of AutoCAD, you were using object color to control pen 
number, linetype, and lineweight. 
 

 

 
Using object color in this way 
limited your use of color in 
drawings. By associating color 
with a specific pen, you lost the 
flexibility to work with color 
independent of lineweight and 
linetypes. By default, AutoCAD 
2000 continues to use object 
color to control output effects 
by creating color-dependent plot 
style tables. A wizard for 
importing pen settings is 
available in the Plot and 
Pagesetup dialog boxes. 

 

Named plot styles work independently of object color. You can assign any plot style to any object 
regardless of that object's color. By associating color with a specific pen, you lost the flexibility to work 
with color independent of lineweight and linetypes. With named plot styles, you use the object's color 
property as you do any other property. Named plot style tables are stored in files with the extension .stb.  
For example, if you have a construction project that you are completing in phases, you might use the 
following procedure: 
 

Create one plot style table that defines plot styles such as Phase 1 and Phase 2 for objects affected by 
different phases of the project. Phase 1 objects might plot in red while Phase 2 objects use gray scale.  

Using the Properties window (PROPERTIES), assign the Phase 1 plot style to phase 1 objects and 
assign the Phase 2 plot style to phase 2 objects. 

 Create another plot style table that reverses these two plot effects.  
 

Assigning these plot style tables to the same layout, you can create two completely different plots. 
 
To change the plot style mode 
 

• From the Tools menu, choose Options. 
• Under Default Plot Style Behavior for New Drawings, specify the plot style mode you want to use by 

choosing one of the following options: 
Use Color Dependent Plot Styles 
Use Named Plot Styles 

• Choose OK. 
 
To see the effect of this change, you must start a new drawing or open a drawing that has not yet been 
saved in AutoCAD 2000. This change does not affect the current drawing. 
 

When you use plot styles, you have the option to display the changes to object properties in the layout 
when you regenerate the drawing. You don't have to plot the drawing to see the results. Displaying plot 
styles can slow performance. If you choose not to display plot styles in the drawing, you can view them 
using the Full Preview option in the Plot dialog box. 
 
To display plot styles in a drawing 
 

• Choose the layout tab where you want to view plot styles. 
• From the File menu, choose Page Setup. 
• On the Plot Device tab, under Plot Style Table (Pen Assignments), select Display Plot Styles. 
• Choose OK. 
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Creating Plot Styles 
 

You can create a plot style table to utilize all the flexibility of named plot styles or you can create a color-
dependent plot style table to work in a color-based mode. Named plot style tables contain plot style 
definitions named STYLE1, STYLE2, and so on. You can add new styles and change their names to more 
descriptive names if you choose: for example, CONSTRUCTION PHASE 1, LANDSCAPING PHASE, or 
WATERPIPES. Color-dependent plot style tables contain 255 plot styles named COLOR_1, COLOR_2, 
and so on. Each plot style is tied to an ACI color. You cannot add or delete color-dependent plot styles or 
change their names. 
 

When you create a plot style table, you can start from scratch, modify an existing plot style table, import 
style properties from an acadr14.cfg file, or import style properties from an existing PCP or PC2 file.  
Plot style tables hold the definitions of plot styles and are stored as CTB and STB files in the AutoCAD 
2000\plot styles folder. 
The following procedure creates a named plot style table. See the procedure that follows it to create a color-
dependent plot style table. 
 
To create a named plot style table 
• From the Tools menu, choose Wizards  Add Plot Style Table. 
• In the Add Plot Style Table wizard, read the introductory text. Choose Next. 
• On the Begin page, choose one of the following options, and then choose Next. 

• Start from Scratch: Creates a new plot style table. 
• Use an Existing Plot Style Table: Creates a new named plot style table using an existing named 

plot style table as a starting point. The new plot style table includes the styles from the original 
plot style table. 

• Use My AutoCAD Release 14 Plotter Configuration: Creates a new plot style table using the pen 
assignments stored in the acadr14.cfg file. Choose this option if you want to import settings but 
don't have a PCP or PC2 file. 

• Use a PCP or PC2 File: Creates a new plot style table using pen assignments stored in a PCP or 
PC2 file. 

• On the Pick Plot Style Table page, select Named Plot Style Table. Choose Next. 
• If you are importing information from a CFG, PCP, or PC2 file, on the Browse File Name page, 

specify the full path for the file you want to use or choose Browse to locate the file.  
 

If you are importing information from a CFG file, you must also specify the plotter whose settings you 
want to use. The CFG file may contain information for more than one plotter. 
 

• On the File Name page, enter a name for the plot style table, and then choose Next. 
• On the Finish page, if you want to attach this plot style table by default to all new drawings and pre-

AutoCAD 2000 drawings, select Use This Plot Style Table for Layouts in New Drawings. 
 

Clear this option if you don't want to attach this plot style table to new drawings and pre-AutoCAD 2000 
drawings by default. 
 

• Choose Finish to create a named plot style table and exit the wizard.  
 
The resulting STB file is listed in the Plot Style Manager. Depending on the option you specified in step 3, 
the plot style table either contains the default style, NORMAL, or a number of styles from an existing plot 
style table or acadr14.cfg, PCP, or PC2 file. 
 
To create a color-dependent plot style table 
 

• From the Tools menu, choose Wizards  Add Plot Style Table. 
• In the Add Plot Style Table wizard, read the introductory text. Choose Next. 
• On the Begin page, choose one of the following options, and then choose Next. 

Start from Scratch: Creates a new plot style table. 
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Use My AutoCAD Release 14 Plotter Configuration: Creates a new plot style table using the pen 
assignments stored in the acadr14.cfg file. Choose this option if you want to import settings but don't 
have a PCP or PC2 file. 
Use a PCP or PC2 File: Creates a new plot style table using pen assignments stored in a PCP or PC2 
file. 

• On the Pick Plot Style Table page, select Color-Dependent Plot Style Table. Then choose Next. 
• If you are importing information from a CFG, PCP, or PC2 file, on the Browse File Name page, 

specify the full path for the file you want to use or choose Browse to locate the file.  
 
If you are importing information from a CFG file, you must also specify the plotter whose settings you 
want to use. The CFG file may contain information for more than one plotter. 
 
• On the File Name page, specify a name for the plot style table. Choose Next. 
• On the Finish page, if you want to attach this plot style table by default to all new drawings and pre-

AutoCAD 2000 drawings, select Use This Plot Style Table for Layouts in New Drawings. 
 
Clear this option if you don't want to attach this plot style table to new drawings and pre-AutoCAD 2000 
drawings by default. 
 
• Choose Finish to create a color-dependent plot style table and exit the wizard.  
 
The resulting CTB file is listed in the Plot Style Manager. The plot style table contains 255 styles, one for 
each AutoCAD color. You cannot add, delete, or rename styles in a color-dependent plot style table. 
 
 
Editing Plot Styles 
 

You can modify the plot styles in the plot style table attached to the Model tab or layout. Changes you 
make to a plot style affect the objects to which that plot style is assigned. 
You can add, delete, copy, paste, and modify plot styles in a plot style table by using the Plot Style Table 
Editor. You can open more than one instance of the Plot Style Table Editor at a time. In the Table View 
you can copy and paste plot styles between plot style tables.  
 
Open the Plot Style Table Editor using any of the following methods: 
 

• Right-click a CTB or STB file in the Plot Style Manager and then choose Open from the shortcut 
menu. 

• Choose Plot Style Table Editor from the Finish screen in the Add Plot Style Table wizard. 
• In the Page Setup dialog box, select the Plot Device tab. Under Plot Styles, select the plot style table 

you want to edit from the Plot Style Table list. Choose Editor. 
• In the Select Plot Style dialog box or Current Plot Style dialog box, choose Editor. 
 On the Plot Device tab of the Plot dialog box or Page Setup dialog box, choose Edit. 
 In the Options dialog box, choose Add or Edit Plot Style Tables. 
 
The Plot Style Table Editor displays the plot styles contained in the specified plot style table. The editor has 
three tabs: General, Table View, and Form View. 
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The General tab lists the plot style table, description, version number, and location (path name). You can 
modify the description, and you can apply scaling to non-ISO lines and to fill patterns.  
 

Plot Style Table Name- Displays the name of the plot style table file you are editing. 
Description- Provides a description area for a plot style table. 
File Information- Displays information about the plot style table you are editing: number of plot styles, 
path, and version number of the Plot Style Table Editor. 
Apply Global Scale Factor to Non-ISO Linetypes and Fill Patterns- Scales all the non-ISO linetypes 
and fill patterns in the plot styles of objects controlled by this plot style table.  
Scale Factor- Specifies the amount to scale non-ISO linetypes and fill patterns. 
Delete R14 Color Mapping Table- Named plot style tables that you create using acadr14.cfg, PCP, or 
PC2 files contain plot styles that are created from your AutoCAD Release 14 pen mappings. Color-
dependent plot style tables also have color mapping tables. AutoCAD uses color mapping tables to map 
plot styles to colors and thus to objects of each color when opening pre-AutoCAD 2000 drawings. While 
the color mapping table exists, you cannot add, delete, or rename plot styles in that plot style table. 
If you delete a color mapping table, AutoCAD cannot automatically assign plot styles to objects when pre-
AutoCAD 2000 drawings are opened for the first time. 
If you delete the mapping table, the plot style table becomes an ordinary plot style table and is no longer 
useful for applying plot styles to old drawings. It continues to be useful for new drawings. 
The Style Settings tab lists all of the plot styles in the plot style table and their settings. Plot styles are style 
overrides for your drawings that occur during plotting. You can modify plot style color, screening, linetype, 
lineweight, and other settings. Plot styles are displayed in columns from left to right. You can use either the 
Table View tab or the Form view tab to adjust plot style settings. 
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In general, the Table View 
tab is convenient if you have 
a small number of plot styles. 
You can modify plot style 
color, screening, linetype, 
lineweight, and other settings. 
On the Table View tab, Plot 
styles are displayed in 
columns from left to right. 
The setting names for each 
row appear at the left of the 
tab.  

 
 

 
 
 

 

 
If you have a large number of 
plot styles, the Form view is 
more convenient because the 
plot style names  are listed at 
the left and the properties of 
the selected style are 
displayed to the right. The 
first plot style in a named plot 
style table is NORMAL and 
represents an object's default 
properties (no plot style 
applied). You cannot modify 
or delete the NORMAL style. 
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Description- Provides a description for each plot style. 
 

Color- Specifies the plotted color for an object. The default setting for plot style color is Use Object Color. 
If you assign a plot style color, the color overrides the object's color at plot time. You can choose Other to 
display the Select Color dialog box. 
 

Enable Dithering- Enables dithering. A plotter uses dithering to approximate colors with dot patterns, 
giving the impression of plotting more colors than available in the AutoCAD Color Index (ACI). If the 
plotter does not support dithering, the dithering setting is ignored. Turning off dithering also makes dim 
colors more visible. When you turn off dithering, AutoCAD maps colors to the nearest color, resulting in a 
smaller range of colors when plotting. Dithering is available whether you use the object's color or assign a 
plot style color. 
 

Convert to Grayscale- Converts the object's colors to gray scale if the plotter supports gray scale. If you 
clear Convert to Grayscale, AutoCAD uses the RGB values for object colors 
 

Use Assigned Pen Number (Pen Plotters Only)- Specifies a pen to use when plotting objects that use this 
plot style. Available pens range from 1 to 32. If plot style color is set to Use Object Color, or you are 
editing a plot style in a color-dependent plot style table, you cannot change the assigned pen number; the 
value is set to Automatic. If you specify 0, the field updates to read Automatic. AutoCAD determines the 
pen of the closest color to the object you are plotting using the information you provided under Physical 
Pen Characteristics in the Plotter Configuration Editor. 
 

Virtual Pen Number- Specifies a virtual pen number between 1 and 255. Many non-pen plotters can 
simulate pen plotters using virtual pens. For many devices, you can program the pen's width, fill pattern, 
end style, join style, and color/screening from the front panel on the plotter. 
Enter 0 or Automatic to specify that AutoCAD should make the virtual pen assignment from the AutoCAD 
Color Index. 
The virtual pen setting in a plot style is used only by non-pen plotters and only if they are configured for 
virtual pens. If this is the case, all the other style settings are ignored and only the virtual pen is used. If a 
non-pen plotter is not configured for virtual pens, then the virtual and physical pen information in the plot 
style is ignored and all the other settings are used. 
 

Screening- Specifies a color intensity setting that determines the amount of ink AutoCAD places on the 
paper while plotting. The valid range is 0 through 100. Selecting 0 reduces the color to white. Selecting 100 
displays the color at its full intensity. 
 

Linetype- Displays a list with a sample and a description of each linetype. The default setting for plot style 
linetype is Use Object Linetype. If you assign a plot style linetype, the linetype overrides the object's 
linetype at plot time. 
 

Adaptive Adjustment- Adjusts the scale of the linetype to complete the linetype pattern. If you don't select 
Adaptive Adjustment, the line might end in the middle of a pattern. Turn off Adaptive Adjustment if 
linetype scale is important. Turn on Adaptive Adjustment if complete linetype patterns are more important 
than correct linetype scaling. 
 

Lineweight- Displays a sample of the lineweight as well as its numeric value. You can specify the numeric 
value of each lineweight in millimeters. The default setting for plot style lineweight is Use Object 
Lineweight. If you assign a plot style lineweight, the lineweight overrides the object's lineweight at plot 
time. 
 

Line End Style- Provides the following line end styles: Butt, Square, Round, and Diamond. The default 
setting for Line End Style is Use Object End Style. If you assign a line end style, the line end style 
overrides the object's line end style at plot time. 
 

Line Join Style- Provides the following line join styles: Miter, Bevel, Round, and Diamond. The default 
setting for Line Join Style is Use Object Join Style. If you assign a line join style, the line join style 
overrides the object's line join style at plot time. 
 

Fill Style- Provides the following fill styles: Solid, Checkerboard, Crosshatch, Diamonds, Horizontal Bars, 
Slant Left, Slant Right, Square Dots, and Vertical Bar. The default setting for Fill Style is Use Object Fill 
Style. If you assign a fill style, the fill style overrides the object's fill style at plot time. 
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